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From The Chief Editor's Desk
 


Sweet Sixteen.


Yep. That's how old PCLinuxOS will be on October 24, 2019. Over those 16 years, we've seen many changes, and yet there's a lot that remains the same and a constant. People, as always, have come and gone. KDE has always been the "main" desktop offering. Over the years, PCLinuxOS has also been available with FluxBox, Openbox, Xfce, Gnome 2, Mate, LXDE, LXQt, Cinnamon, Trinity, JWM, Enlightenment, and other assorted desktop "flavors."

 

 


The most consistent constant, though, has been Texstar at the helm, guiding this awesome Linux distro through sometimes turbulent Linux waters. Tex has managed to keep PCLinuxOS free from the systemd curse that has plagued most other Linux distros, and has vowed to continue to do so for as long as he can. Today, PCLinuxOS is one of the very few systemd-free Linux distros in existence.


Those of us who have been around for a while (I've been here for about 12 years) have heard the story about the origins of PCLinuxOS before. I doubt any of us ever get tired of hearing the story again. Meanwhile, there are always new people who have never heard the story of how PCLinuxOS came about. What follows is Texstar's description of the events.



In the summer of 2003, I became interested in Live CD technology after looking at Knoppix and a fresh distribution from a fellow named Warren, called Mepis. I was interested in helping Warren with Mepis at the time, but I had no clue how to build DEB files. Coming from 5 years of packaging RPMS and not really wanting to learn a new packaging system, I happened to come across a South African fellow by the name of Jaco Greef. He was developing a script called mklivecd and porting it to Mandrake Linux. I, along with Buchanan Milne (Mandrake contributor) and a few others, began working with Jaco to help debug the scripts. I got an idea to make a livecd based on Mandrake Linux 9.2, along with all my customization's, just for fun. I had previously provided an unofficial 3rd party repository for the users of Mandrake for many years, but had since parted ways. Since Mandrake was a trademarked name, myself and others decided to name the Live CD after our news site and forum, pclinuxonline, thus PCLinuxOS.


Preview .3 was my first attempt to make a livecd. I distributed it initially to about 20 people to get their reaction and feedback. Everyone who tested it loved the livecd but there was one thing missing. There wasn't a way to install the thing to the hard drive! srlinuxx from tuxmachines.org came up with a novel way to copy the livecd to the hard drive and posted it on our forums. Jaco utilized this information and inspiration from the Mepis installer and wrote a pyqt script to make the Live CD installable, thus the birth of a new distribution.


On October 24, 2003, PCLinuxOS Preview .4 was released as a fork of Linux Mandrake (Mandriva) 9.2 utilizing mklivecd scripts from Jaco Greef, a multimedia kernel from Thomas Buckland (2.4.22-tmb) and a customized KDE (3.1.4-tex). Preview .5 through .93 were built upon on previous PCLinuxOS releases. After three years of updating one release from the other using the same gcc and glibc core library, we found too many programs would no longer compile or work properly against this aging code base.


In November 2006, we utilized a one time source code snapshot from our friends at Mandriva to pull in an updated glibc/gcc core and associated libraries. We spent the following 6 months rebuilding, debugging, customizing, patching and updating our new code base. We pulled in stuff from our old code base, utilized patches/code from Fedora, Gentoo and Debian just to name a few. This is why you will never see me distro bashing, as it would be hypocritical to do such a thing. We are still dependent in many areas on other distros development processes due to our limited but hard working volunteer development team.


On May 20th, 2007, we felt we had reached a pretty stable base and released PCLinuxOS 2007. It utilized our own kernel from Oclient1, KDE built by MDE developer Ze, updated mklivecd scripts from IKerekes & Ejtr, a heavily patched Control Center, graphics from the PCLinuxOS beautification team, and many application updates from Thac and Neverstopdreaming. Development continues as work is being done for a Minime release and an international DVD. A future release of PCLinuxOS will feature an updated kernel, KDE 4, fresh Xorg server and all the latest applications. All in all it has been a great ride and we have made many friends along the way. Some have gone on to other distributions and many are still here from our first release. As I've always said, we're just enjoying Linux technology and sharing it with friends who might like it too. We hope you have enjoyed the ride as well.





Today, PCLinuxOS only supports 64 bit processors, having dropped support for 32 bit processors a couple of years back. Most other Linux distros have also dropped support for 32 bit processors in recent years, so PCLinuxOS isn't bucking the trend. There are exceptionally few Linux distros that support 32 bit processors today, in fact.


It's easy to understand, too. I can't imagine maintaining two versions (32 bit and 64 bit) of each package, and ensuring that both work as they are supposed to before being released into the stable repositories. Since most computers sold in the past eight to ten years sport 64 bit processors, most of the computers running PCLinuxOS today will have 64 bit processors. It only makes sense, given the limited resources of PCLinuxOS's relatively small, volunteer development team, to focus on support for the processor that most people are going to be using.


PCLinuxOS doesn't have any millionaire/billionaire donors, and isn't supported by any large corporation(s). It's just a bunch of people interested in Linux and interested in putting out the best rolling release Linux distro that they can. Without a doubt, they have succeeded famously. And all while relying on the generosity and small donations from its user base to keep the bills paid and to keep things going.


PCLinuxOS's motto (for as long as I can remember) has been "radically simple." Even today, that motto shines bright. Everything. Just. Works. And it works exceptionally well. In fact, it works so well that sometimes it's boring. But I'll take being bored over the constant onslaught of viruses, malware, spyware, crapware, and any other kind of "ware" with a negative connotation, any day!


So, Happy Birthday, PCLinuxOS! May there be many, many more birthdays in the years to come!


Until next month, I bid you peace, happiness, serenity and prosperity.




 
 

 
 









 
Short Topix: Julian Assange To Remain Jailed Pending Extradition To U.S.
 



by Paul Arnote (parnote)


Over 400 Million Facebook Users' Phone Numbers Exposed

 

 


According to a TechCrunch article, over 419 million phone numbers linked to Facebook accounts were found on an unsecured, exposed server. This included 133 million U.S. Facebook users, 18 million U.K. Facebook users, and another 50 million Facebook users from Vietnam. The server wasn't even password protected, allowing basically anyone unfettered access to the data.


The exposed records linked a user's unique Facebook ID number to their phone number. In some of the records, the data included the the user's name, gender and country of residence. Ironically, user phone numbers have not been publicly available for the past year since Facebook restricted access to them. And yet here they sit, unprotected on an exposed server. The database has since been taken offline.


Facebook has maintained that the data exposed was "old data," scraped at a time from before Facebook restricted access to user phone numbers and may have been placed on the server by others looking to store it for later retrieval. Still, many persons' phone information does not change all that often.


Sanyam Jain, a security researcher and member of the GDI Foundation, discovered the database. He contacted TechCrunch after he was unable to find its owner. In his examination of the database, he was even able to find profiles -- with their associated phone numbers -- of several celebrities.


Just in case you ever needed yet another reason to NOT have a Facebook account ... here it is.

 

Library of Congress: Nearly 12,000 Public Domain Photos of Roadside Americana

 

 


The U.S. Library of Congress has released nearly 12,000 images from John Margolies into the public domain. The library purchased the rights of the photos from the architectural critic and photographer, who spent forty years documenting his travels along U.S. highways. The photographs include billboards, drive-in theaters, banks, city halls, movie theaters, diners, novelty buildings, miniature golf courses and other roadside attractions.


Most (if not all) of the images are released as either JPG or TIFF file copies of image transparencies. The original transparencies have subsequently been placed into controlled-climate storage to help insure preservation. Each image is offered in a high and low resolution JPG, and a high and low resolution TIFF file.


Many unique buildings, structures and attractions still exist along the roads and highways of America. These buildings, like the one pictured above of the old Teepee Junction gas station in Lawrence, Kansas at the junction of U.S. Highway 40 and U.S. Highway 59, have a lot of character.


What's even better is that the images were released into the public domain, so you can use the images as you see fit, even for commercial applications.


Julian Assange To Remain Jailed Pending Extradition To U.S.

 

 


Julian Assange's 50 week jail sentence for jumping bail by hiding out in the Ecuadorian Embassy for seven years was scheduled to end September 22, 2019. However, U.K. Home Secretary Sajid Javid signed an order this past June allowing Assange's extradition to the U.S. over hacking allegations.


The 48 year old Australian appeared before the court via a video link, wearing a loose fitting t-shirt. During the proceedings, district judge Vanessa Baraitser told Assange:


"You have been produced today because your sentence of imprisonment is about to come to an end. When that happens your remand status changes from a serving prisoner to a person facing extradition.


"Therefore I have given your lawyer an opportunity to make an application for bail on your behalf and she has declined to do so, perhaps not surprisingly in light of your history of absconding in these proceedings.


"In my view I have substantial ground for believing if I release you, you will abscond again."



When Assange was asked if he understood what was happening, he replied "Not really. I'm sure the lawyers will explain it."


An administrative hearing on the case is expected on October 11, and a case management hearing on October 21. The final extradition case isn't expected to happen until February, 2020.


Windows 11 Running Linux Kernel?

 

 


Say what? Microsoft Windows 11 running a Linux kernel? What'chu smokin'? Steven J. Vaughan-Nichols wrote such a speculative article for ComputerWorld.


And actually, it makes perfect sense. Look at the unmitigated disaster that the Windows 10 updates have been. Week after week after week, we hear about how the Windows 10 updates have wrecked users computers or have otherwise gone seriously awry. Most (if not all) Linux users are Windows refugees, usually fleeing from the lack of desktop choice under Windows, the never-ending assault of virii and virus scanners, the endless battle with malware, etc., etc., etc. The list is nearly as long as the number of Linux users.


Replacing the NT kernel, which is basically rotten, with the Linux kernel is certainly doable. Vaughan-Nichols makes the argument that using the Linux kernel that is passionately and enthusiastically upkept by an army of programmers from around the world makes perfect sense. He goes on to argue that many Windows users won't even have to be aware that Windows is running on a Linux kernel, as Windows can still be made to look like Windows. But the insides, the very core, will get an upgrade in stability and security.


Sure, it sounds crazy. But who could have predicted that Microsoft would go from wanting to bury Linux and calling it a cancer under Steve Ballmer, to expressing love for Linux under Satya Nadella? Who could have predicted that Microsoft would open its extensive patent library to Linux and the FOSS community -- for free?


Vaughan-Nichols goes on to point out that Microsoft could release its own version of Linux today, if it chose to. There's nothing to stop them. But Microsoft developers have been busy laying the groundwork with the Windows Subsystem for Linux (WSL), mapping Linux API calls to Windows, and vice versa.


It would be perfectly understandable that Linux users might want to approach this topic cautiously. After all, it wasn't all that long ago that Ballmer and friends were looking to torch, hang, stab, shoot, and otherwise kill and bury Linux. According to Ballmer, Linux and FOSS were a "cancer." Many Linux users view Microsoft in that context. They are wary to invite the wolf into the lamb's enclosure.


Microsoft Wants You To Learn Python ... For FREE!

 

 


The PCLinuxOS Magazine has been running an article series by critter (Pete Kelly) for much of the past year to teach you the basics of Python programming. Now, Microsoft is also wanting to teach you Python programming. They have launched a 44 part series on YouTube, called Python for Beginners. Each "episode" lasts for three or four minutes, hosted by two self-described Microsoft geeks who love programming and teaching.


While the course focuses on Python 3.x, users of Python 2.x should also find value. Microsoft has also published additional resources for the course on GitHub, including slides and code samples. The Microsoft course focuses on AI machine learning.


Some of the latest polls have placed Python programmers among those most in demand in the IT world. Recently, the Python programming language was rated the most popular, followed by C++, Java, then C.


So, if you're looking for something to supplement critter's excellent and informative tutorial articles, this video series may just be what you are looking for.




 
 


 
 










 
Analysis: The Fall Of Stallman
 



by Alessandro Ebersol (Agent Smith)                   


 


Figure 1: Super Stallman being taken away by the PC thought police
 


Richard Matthew Stallman, the founder of the GNU movement, resigned from his position as president, and left the board of the Free Software Foundation, on September 16, 2019, after external pressure over comments he would have made about pedophilia and Jerry Epstein.

 

But what actually happened?


Richard Stallman sent emails to an MIT CSAIL mailing list earlier this month. In the emails, Stallman tried to defend the reputation of late MIT teacher Marvin Minsky, with whom Epstein's victim Virginia Giuffre said she was forced to have sex during a trip to the Virgin Islands at the age of 17. Well, Stallman argued, on that MIT mailing list that using the term rape would be very serious (defending the memory of his former teacher, and, I believe, friend).


Now Stallman is a man almost completely detached from our reality. Anyone who knows him says he's almost an Asperger, so his opinions should not be taken so seriously given his background.

 

But the media responded swiftly and ruthlessly.


How did the sites report Stallman's appeal on the CSAIL list?


The VICE website put it this way: "Famous computer scientist Richard Stallman described Epstein's victims as "totally willing"".


And, such headlines and articles were reproduced ad-infinitum on the internet, amplifying a very poorly told story.


Well ... what exactly does this really have to do with what he wrote?


In defending his former teacher, and getting into this discussion of a notorious pedophile, Stallman has already made a mistake. He should not have gotten involved in this, but, as the media described him, it was a colossal attack on Stallman's person, a 100x worse mistake.


To say that Stallman defended Epstein for comments he made about his former teacher are from an oceanic distance. And, he commented, angrily on his blog, about the injustices he suffered online.


Unfortunately, his defenses were forgotten, and all the media preferred the scandal to the truth.


And an online campaign at has put pressure on him to leave, and has succeeded. He did not resist the pressure and resigned from both the MIT and the FSF.

 

So he was a pedophile and defended Epstein?


Negative. It never happened. In fact, who really had ties with that citizen Epstein was Bill Gates, who, according to emails obtained exclusively from The New Yorker, Epstein would have instructed Bill Gates to donate $2 million to a MIT research lab in October 2014. The directors of MIT Media Lab delivered the emails, and they clearly link Gates to Epstein.


However, this connection goes beyond donation, as both Gates and Epstein had a common interest in eugenics, a perverted form of science that seeks to genetically improve the human population by getting rid of undesirable ones (who was also interested in that? Hmmm, ahhh, that Austrian guy!)


We can even speculate that the attack on Stallman's person was a way to get the public's attention diverted away from Gates, who really had a connection with Epstein.


Now, let's move a little away from the passion that this theme arouses. Let's look at the Stallman person. And, let's think for a moment.

 

Stallman has always been awkward, and his comments have not helped him, on the contrary.        


Here justice must be done: Stallman was never aware of the danger he was putting himself into, engaging with sexual issues (sex with minors, sexual violence and so on). Several times he made comments on his personal blog that did not go well. In 2003, in 2006, in 2013, etc.


But what he did was, without any tact, expressing his ideas and opinions, without taking into account that the era of freedom of expression was already over. Yes, nowadays, with the PC thought police, who are always on the lookout for any subject to fire their cannons on, that free speech is gone. If an opinion expressed goes against the prevailing zeitgeist, the subject is in hot waters. And, add to that a corporate yellow media, plus fake news, and you get a sad scenario.

 

The media has never been sympathetic to Stallman         


No, never. Either he didn't take a shower, or he bit his nails, but the fact that they treated him with disrespect, indifference or as a joke always occurred. I doubt if this was motivated (albeit in a hidden way) by Stallman's biggest enemy and what he stands for (the four freedoms), Microsoft.

 

The cancer has never ceased to be cancer...


Steve Ballmer once called GNU/Linux cancer, and GPL a disease that would make everything open source.


In fact, Ballmer was wrong to call free software open source, but back then they were little different. Not today. Today, the so-called "open source" is moving further and further from free software.


But let's get back to Microsoft, GPL, and Stallman.


At a time like today, where Microsoft increasingly declares its love for Linux, we are always faced with open source apologists from Microsoft, and how it is committed to its advancement(open source) and improvement.


But what about free software? What about the four freedoms? Nothing. The company says nothing about it, and apparently to hear it doesn't exist. That is, Microsoft may love Linux, but it does not love the freedom of the GNU movement (which is intrinsically linked to the Linux kernel and the way it is developed). As a colleague posted on social network: "Microsoft may love Linux, but it doesn't love its users," a hard and strong truth.


And in a media maneuver, Stallman was invited to speak at Microsoft, yet another advertisement for how the company "loves Linux" today. And interestingly, days after his visit to the company, all this scandal explodes ...


At a time like this, with so much "love" in the air, let us not forget that Ballmer himself said: "I would love to see all the innovation of open source happen on Windows".


What prevented that from happening? The four freedoms? Or his greatest advocate? Who knows.


The thing is, the biggest vocal advocate of the GNU copyleft licenses and the four freedoms was Stallman. Having resigned, who will play his part? And his vacant space paves the way for further corporate exploitation of all the work he has done and was committed to.

 

Corporations are merciless, evil and heartless. But it's the free software folks who are almost always in the headlines...



Yes, this is a recurring theme: Any advocates, or developers of free software, or free culture, are always in the sights, whether of the corporate media or "Defenders" of social justice movements.


Otherwise, let's see:


 	 Jacob Appelbaum, one of the developers of the TOR protocol: Allegations of sexual misconduct.


 	 Julian Assange (Wikileaks): Accused of sexual violence in Sweden.


 	 Brendan Eich: Former CEO of Mozilla Foundation, had to resign for donating to the movement "Proposition 8" in California at a time when one of Eich's plans was to launch Firefox OS for mobile devices (phones, tablets).


 	 Theodore T'so: Accused of an apologist for sexual violence . Note that T'so was against Intel's TPM platform (which was Sharp's employer).


 	Linus Torvalds: All development of the Linux kernel has been branded as toxic by the extremely sincere personality of Torvalds' . And the public outcry was such that Linus had to adopt a COC and take a vacation from the direction of the development of the Linux kernel.




So how many bad people in free software, huh?


But it's just not true. Steve Jobs was a nasty human being, and Microsoft is one of the most sexiest companies there is. But no, the bad guys are these free software guys and activists.

 

Jobs and Microsoft, exemplary citizens


Steve Jobs was a scoundrel. He wanted nothing to do with his daughter for a long time.


Jobs denied his daughter Lisa's paternity for years. She and her mother ended up living on government welfare.


Daughter Lisa Brennan wrote a memoir about her relationship with her famous father, Small Fry, where she describes Jobs as a sadistic man and a horrible father: sexually inappropriate, verbal and psychologically abusive, ruthless and cheap - with his time, money, emotions, attention.


But the media treated him like the Jesus of technology. Did anyone talk bad about him in the newspapers? On the Internet? In blogs?


While he was alive, no, but the media, so merciful about this "wonderful human" being, never spared free software activists. They always condemned them and lynched publicly. And Microsoft is no different. In 2015, it was the subject of a labor lawsuit over sexual discrimination.


"Katherine Moussouris filed a complaint against the Seattle-based company, claiming that her supervisors disliked her "manner of style" and gave the promotions she was up to to her less qualified male colleagues, Reuters reported. She also received lower bonuses as retaliation for making complaints of sexual harassment. According to the complaint, Microsoft employees in Redmond, Washington often received lower performance ratings and were based on subjective observations."


And that didn't change with Satya Nadella, quite the opposite: In October 2015, he told, in a room full of technical women at the Grace Hopper Conference, that they should not ask for a raise, but instead have "faith that the system will provide the right raise." ARGHHHHH! Yeah, with Microsoft, only with a lot of faith, really.


He apologized later, but apologies don't change anything. Of course, having several technical news sites in its pockets helps to silence criticism of Microsoft.

 

And Stallman and his accuser?
 

Was Stallman a pedophile? No.


Encouraged pedophilia? He didn't.


Defended Epstein? No, and on his blog, made harsh criticism of the late sex offender.


But he paid dearly for no crime. He did nothing but try to defend a former teacher. But that can be a disaster these days because of digital lynch mobs.


And his accuser? Facing a strong public backlash, she took down her personal website (her website calling for Stallman's resignation is still online), but can still be found here.


Did she act in good faith? Maybe, maybe not.


The only thing I know is that she's a millennial, and they think they can destroy everything and build something new in its place, even better than there was. But I highly doubt that they can build anything better than it was (and still is), the GNU movement. RMS is not out of the game, and we look forward to his return to the field. Voices are rising in his defence, and, we can only hope this injustice to be undone quickly.


 
 

 
 

 
 


 
 


 
 


 
 


 
 









 
ms_meme's Nook: Hey, Hey, Texstar!
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PCLinuxOS Recipe Corner: Slow Cooker Salsa Chili
 




Slow-Cooker Salsa Chili



Ingredients:


1 lb lean (at least 80%) ground beef

1 medium onion, chopped (1/2 cup)

2 cups Thick 'n Chunky salsa

1 can (15 oz) tomato sauce

1 can (4.5 oz) chopped green chiles

2 teaspoons chili powder

1 can (15 to 16 oz) pinto beans, drained, rinsed

Shredded Cheddar cheese, if desired

Sliced green onions, if desired


Directions:


1. In 10-inch skillet, cook beef and onion over medium heat 8 to 10 minutes, stirring occasionally, until beef is thoroughly cooked; drain.



2. In 3 to 4 quart slow cooker, mix beef mixture and remaining ingredients except beans.



3. Cover; cook on Low heat setting 8 to 10 hours.



4. Stir in beans. Cover; cook on Low heat setting about 5 minutes longer or until beans are hot. Top with cheese and onions.


Expert Tips:


Vary the taste by using black beans instead of pinto beans. If you like a milder chili, use mild salsa and a little less chili powder.


If you like, cook up a double batch of this hearty chili, then refrigerate or freeze half for another night. If you do make a double batch, use a 5 to 6 quart slow cooker.




 
 

 
 









 
Inkscape Tutorial: Five Inkscape Essentials
 



by Meemaw


I found this tutorial while I was looking for some technical information about Inkscape, and I thought maybe there were more than just me who didn't know some of these methods. As I've said before, I don't know everything about Inkscape, so I'm constantly searching for articles or tutorials to expand my knowledge (I believe I actually only know enough to be dangerous!)

 

Erasing in Inkscape


Every time I chose the eraser tool in Inkscape, I was disappointed because it didn't work like I thought it should. Just goes to show what I just said about not knowing everything. Technically, you can't "erase" with vector design. Everything is based on points and lines, so you'll actually have to add/change the points in order to give the illusion of erasing. Let's see how we do this using a circle:

 

 


Choose the Eraser tool, change the mode to Cut out from objects, and set the brush Width: 25. Erase across your circle.

 

 


Yikes! That's not what I wanted at all! Using the eraser added about 100 nodes to our simple circle. It also looks really rough.

 

 


The best way to erase in Inkscape is to use boolean path operations. Instead of the eraser, we'll be using the Pen tool to draw a line similar to the previous eraser scrub. The good thing about this is that you can adjust your nodes before you erase.

 

 


We wanted a larger area erased, so we'll adjust the stroke width. While you have the line chosen, click on Path > Stroke to Path. Then, go to your Properties window and adjust the stroke size to however wide you want. I made mine 12 but you can make it any size.

 

 


With both the circle and the line selected, go to Path > Difference complete your erasing. This looks much smoother than the first try.

 

 


Here you can see the difference in the two methods. The one on the left was done with the eraser tool and the one on the right was done with the pen tool and Path > Difference.

 

 


Curving Text


Sometimes in your graphics creation, you want something that's not just straight text, but you want it to have some shape to it. You can draw a line to illustrate the curve you want your text to have, but what to do next? Fortunately, I found out, this is fairly easy in Inkscape.


Create your text, configuring it however you want, then draw a line with the bezier tool, and edit the line so it has the curve you need. 

 

 


Select the text and the curve, then click on Text > Put on Path.

 

 


You can change the color of your line (or make it transparent) so it's not visible in your project. To move your text easily to where you want it, you should group the text and line as well.

 

 


Cropping an object


Sometimes you want to use a certain object but it needs to be cropped. In other programs, you just draw the rectangle and choose "Crop", but Inkscape doesn't work that way, so we'll have to do it differently.


Import the object you want to use, and size it down to the size you want. I have an image of a penguin I want to use for a Christmas project, but I only want the head, so I will import the image, then draw a rectangle (or even a circle) over the area I want to use. I made the rectangle a little transparent so I could see what I was cropping.

 

 


Select the image and the rectangle (making sure the rectangle is on top) and click on Object > Clip > Set. Everything within the rectangle will be visible, and everything else will be invisible. What makes this nice is that you don't have to stop, open another program, and crop your image there - you can stay in Inkscape.

 

 


Merging Layers


The first thing you need to know is that merging layers in Inkscape doesn't work like it does anywhere else - so let's look.


I have drawn some rectangles and circles in two layers. The rectangles are in layer 1 and the circles are in layer 2, above layer 1. Open the Layers toolbox to get started.

 

 


Make sure both of the layers you want to merge are unlocked. Select them all and use <CTRL>+X to cut them. 

 

 


Now we have a couple of choices: we can paste <CTRL>+V our objects to an existing layer, or create a new one. I chose to paste them all on layer 1. I will then delete layer 2 since it has nothing on it.

 

Tracing A Photo


This one might not be used so much, but it looked fun, so I left it in the list. We'll use Trace Bitmap to trace a photo.


Import your photo and make sure it's selected. I used a photo of our favorite editor and his lovely wife.

 

 


Now, choose Path > Trace Bitmap and you'll get a menu. Brightness cutoff 0.450 is default, so I left it there, then clicked OK. You might play with the settings if it's too dark or too light. I'm sure that it depends on the photo.

 

 


The generated vector drawing will be lying on top of the original photo, but you can grab it and move it. Here, I have moved it to the right of the original photo.

 

 


Of course, now that it's a vector drawing, you can do all sorts of different things to it if you wish, even changing the color.
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Casual Python, Part 9
 








































 
 

 
 


 
 









 
PCLinuxOS Family Member Spotlight: oulik.jan
 



As told to YouCanToo


What is your name/username?

oulik.jan


How old are you?

61



Are you married, single?

Single.



How about Kids, Grandkids (names and ages)?

No children.



Do you have pets, what is your favorite?

No pets anymore, favorite pets are dogs.



Are you retired, still working and if working, what do you do?

Still working, as a certification engineer (product safety).



Where do you call home? What is it like? IE: weather, scenery

Living in the Netherlands now. before that, I lived in South Africa. I miss South Africa too much, but it is not safe to live there anymore. Netherlands climate: at the moment quite warm, but often rainy, grey weather


 
 


 
 


 
 


 



Where did you go to school and what is your education level?

Netherlands, Bachelor level electronics.



What kind of things you like doing? hobbies, travel, fishing, camping?a

Love traveling. I collect antiques, like cooking, music, watching movies and other good things in life.



Why and when did you start using Linux?

I had a netbook which was running Windows XP. A friend at work told me about Linux, and I said no, not interested for a while. Then the netbook became too slow for words. It took seven to nine minutes just to boot, and there were update errors, etc. So I tried Lubuntu 13.04 on that netbook (as advised by my colleague at work) about June 2013.



Well, the same netbook booted in 45 seconds, I could not believe my eyes.



What specific equipment do you currently use with PCLinuxOS?

Two older laptops, one for home use, and one I take with me when I need to travel.



Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?

My father of 91 uses Linux as well. (Lubuntu) With Windows, he often picked up a virus or other malware, and he has been running Linux virus free since six years now. He is very happy with Lubuntu.



My brothers were in the beginning quite negative about my father using Lubuntu, but now they tend to be neutral about it.



I tried to convince some friends of mine to use Linux, but they perceive it to be too complicated and too different.



Only two friends of mine like it.



What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?

I must say I like PCLinuxOS a lot. The only thing I sorely miss is a program like Mintstick. This program lets me format my USB sticks and SD cards exFAT, which is important for large SD cards and large USB sticks. This is one of the reasons why I still have to use Windows.



Another thing which I like a lot when I am using Xubuntu (which I still use on my entertainment system) is an automatic update/cleanup program. I use uCareSystem Core on the Xubuntu machine and it is wonderful. It is also in use on my father's machine. Yes, you can update with Synaptic package manager, but something like uCareSystem Core would probably make things easier for people to update their systems.

 
 


PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.


If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.





 
 

 
 


 
 


 
 


 
 


 
 









 
Accessing Special Unicode Characters, Made Easy
 



by Paul Arnote (parnote)


I know it has happened to you. You're typing along and all of a sudden you find yourself wanting to access a "special character," such as a copyright symbol, or the trademark symbol, or a different currency symbol.


Sure, for the copyright symbol, you could just use (c), but using the actual symbol -- © -- looks so much more polished. The same thing goes for the using the trademark symbol. (TM) doesn't look nearly as polished as the ™ symbol does. The same can be said for the (r) registered mark, where ® looks a lot more polished. Plus, why use three characters when one will do?


When it comes to currencies, there doesn't seem to be any real alternatives to using the British Pound symbol, the Euro symbol, or any other currency symbol, other than using the actual symbol. Of course, the computer you use should already have the currency symbol you need most often only a keystroke away, but that is often not the case when you are needing to use a currency symbol that isn't native to your area.


So, let's look at some different ways that you can more easily access these -- and any -- special characters.


LibreOffice Writer


If your writing tool of choice is LibreOffice Writer, you are in luck. The LibreOffice developers have made it especially easy for you to access and use special characters.


Go to the "Insert" menu, and select "Special Character..." from the list. It is about 2/3 of the way down the menu. Be sure to choose the font you are wanting to use in the font selection dropdown, since not all fonts may have the characters you are wanting to use.

 

 


Usually, all you have to do is scroll through the list to find the special character you want to use. Look carefully, since it's very easy to overlook it the first (or second) time through the list. Once you find it, and especially if it's a character you will want to use again and again, write the hexadecimal number for the character down on a cheat sheet you keep near your computer. I'll show you why a little later with a shortcut that might just save you a lot of time and trouble.


At the bottom of the dialog box is a line of "Favorite Characters." If the symbol you want to use isn't already in the list of favorites, the button in the image above that says "Remove from Favorites" will instead say "Add to Favorites." Clicking on that button will add that symbol to the "Favorite Characters" section. Similarly, you can remove characters from the list of favorites by simply selecting that character, and selecting the "Remove from Favorites" button.


So, LibreOffice makes it pretty simple to access special characters. But what if you're not using LibreOffice?

 

Use A Character Map


A character map is exactly what it sounds like: a map of all the characters that are available for a given or selected font. For GTK+ users, there's gucharmap. For KDE users, there's KCharSelect. They all work pretty much the same way, and are installable through Synaptic from the PCLinuxOS repository. Since I use Xfce, I have gucharmap installed.

 

 


When you find the character you want to use, double click it, then select the "Copy" button to copy it to the clipboard. Now, you can just paste the item into your document from the clipboard. The only drawback is that each time/session that you want to use the same special character, you will have to go back through the same routine of finding it, double clicking it, and then copying it to your clipboard. None of the character map programs (that I've found) allow you to save frequently used symbols to a special list, like with LibreOffice's special character tool.


Notice at the lower left corner of the window is the unicode code for the symbol. In the graphic above, we highlighted the ® character. Gucharmap tells me that the unicode code for the registered symbol is U+00AE. Again, and especially if this is a symbol you might be using rather frequently, write this code down on your cheat sheet that you keep near your computer.

 


RuneStorm


Our dear and departed friend Tara Rain left us a true gift. She wrote a little utility in GTK+ to specifically allow us to quickly access frequently used symbols. It is called RuneStorm. Unfortunately, at the time of this article, it is not currently in the PCLinuxOS repository. However, you can download the RPM from Tara's website, and install it manually on your computer.


To install it, open a terminal session and get a root prompt. Change directories to where you downloaded the RPM file. Then, type rpm -ivh runestorm-1.3-1.x86_64.rpm at the root prompt. Sit back and wait ... oh, maybe 10 seconds ... and RuneStorm will be installed on your computer. You'll find it listed in the Office section of your PCLinuxOS menu.

 


 
 


 


RuneStorm sits in your notification tray, and sports an icon that looks like the capital Greek Omega symbol ... Ω. Upon first launch, the only "Palette" that is available is the one labeled "Default," like in the image above. Left clicking your mouse on the RuneStorm icon will display a list of available characters, just like in the second image.


Right clicking your mouse on the RuneStorm icon will open a menu. Selecting "Preferences" will open the dialog box (third image) where you can customize the list that appears. You can also create new "Palettes," as I've done here by adding a "Currency" list. Just be sure to click on the "Save" button before you close the dialog box if you make any changes to the existing palette or add a new palette. If you don't, all your additions or changes will be lost when you hit the "Close" button.


Selecting "About" from the right click menu will display the About dialog box for RuneStorm.


To use it, simply left click your mouse on the RuneStorm icon, then select the special character you want to use. That character will then be copied to the clipboard. Just paste the character from your clipboard into your document. It's pretty simple!

 

Use The Keyboard


Ok. This is the reason I've been telling you to write down the codes that are displayed for the special characters on a cheat sheet you keep near your computer. Yes, you can enter these special codes from the keyboard, without having to use any other program to assist you.


Some of my friends from across the Atlantic talk about using the AltGR key combinations to access special characters. But they require you to basically memorize a special keystroke combination to access them. First, I find those keystroke combinations difficult to remember. Second, I sometimes find that they don't always work with my American keyboard layout. Or, maybe it's just me and my clumsy fingers.


Fortunately, there is another way that I think is much easier. Before I reveal it, let me preface it with a caveat. There are reports that this might not work in Qt applications, like are found on KDE. It does, however, work exceptionally well on GTK+ applications. I do not have a KDE installation to try this out on, so your mileage may vary.


Now, remember those codes I told you to write down? Position your cursor where you want the special character to appear. Then, hold down the Ctrl and Shift keys, press U, and then enter the four digit hexadecimal number for the character. So, for the copyright symbol, hold down the Ctrl+Shift keys, press U, and then 00A9. Keep the Ctrl+Shift keys held down the whole time while typing the U and the four digit hexadecimal code! When you release the Ctrl+Shift keys, you should see your special character appear in place of the code you typed.


If, for example, LibreOffice's tool told you that the code for the copyright symbol was A9, then pad it with zeros at the start to make a total of four digits. The hexadecimal number entered must be four digits long.


Below are some common codes to help get you started. Note that the "0's" are zeros, not the letter "O".

 

 


Once you get the hang of it, this is actually a very easy way to access those special characters. By keeping a cheat sheet near your computer, you make it super easy, especially for those special characters you find yourself frequently using. You can also look up a lot of them here or here.


And here's a bonus tip: you can use this method to create your additional custom palettes in RuneStorm. Just type the code in the dialog box in the text entry field, and you'll have quick access to those special characters through RuneStorm.


It's things like this that make me happy to be a Linux user. There are always multiple ways to get things done.




 
 

 
 


 
 









 
Mind Your Step, Part 2
 



by phorneker


This is the second installment of this new series. At the end of the last issue, I had discussed fake email addresses. This past month I collected a series of fake addresses used as the apparent sender of a series of fake emails.


Mail handler applications such as SpamAssassin determine what is a legitimate email and what is a fake email by examining the header information contained in the email.


There are two mechanisms that are used to be sure that what gets sent out from your email account really did come from your email account.


The first is the Sender Policy Framework, which is configured at the domain servers where your domain is hosted (such as GoDaddy).


The second is the DomainKeys Identified Mail standard (http://www.dkim.org) for authenticating the sender of emails. G-Mail already has this mechanism implemented.


So how does an email with a fake sender address get through in the first place?


The answer to that has to do with the Simple Mail Transport Protocol, or SMTP for short. SMTP was designed to get email sent out as quickly and as simply as possible. These days, that is exactly what is wrong with SMTP as a means of sending out emails, especially at a time when we have to worry about identity theft (and its long term consequences).

 

 


So, what goes on behind the scenes when an email is sent?


First, the email client connects to an outgoing SMTP server, then issues an EHLO command to get that server's attention.


The outgoing SMTP server then asks for the SMTP username and password. The email client responds appropriately.


It is here where the spoofing of the sender's email address is possible. The email client issues a MAIL FROM: sender identifier <email address> where sender identifier is the name associated with the email address enclosed in <>.


Next, the email client receives a 250 code meaning “all is well” for the outgoing SMTP server. Then, the email client issues a SEND TO: receiver identifier <email address> where the parameters are for the receiver instead of for the sender.


The main problem here is that the outgoing SMTP server does not check to see if either address is valid or even if either address is legitimate.


Hence, the aforementioned mechanisms, SPF and DKIM are necessary additions to the outgoing SMTP server so that the server can check for authentication of email addresses before the email can be accepted for delivery.


The other part of the problem is that the SMTP client is not necessarily going to be Thunderbird or Claws, or even a web browser. It could be a customized spam generation program written in C++, Java, Python or Ruby.

 

Email Spoofing vs Email Hacking


The fake sender email addresses I collected were the result of email spoofing. email spoofing is to electronic mail what robocalls are to landline and cellular phone service.
The main goal of email spoofing could well be nothing more than to validate your email address to cybercriminals, or could be an attempt to gain vital information needed to steal money, or worse, your identity.


email hacking, however, is a much more serious problem. This means that a cybercriminal somehow gained full access to your email account. (If this happens, it is a good idea to at least change the password, or better yet, close the email account outright.)


This is one reason why everyone should change his/her password on all essential and valuable accounts often (such as your Google account) and make those passwords as difficult to guess as possible. Also, make sure that two factor authentication is enabled wherever and everywhere possible.

 

Hillary Clinton Sure Had The Right Idea...


So what do we do with emails containing spoofed email addresses (especially those in the Spam folder)? Delete them, of course. By deleting them, your email address will never be validated, no matter how often the spam machine is used....and if worse comes to worst, simply close the email account and open a new email account elsewhere. The cybercriminals will eventually get the message.

 

If You Must Close Your Email Account...


Before you decide to close your account, it is a very good idea to contact those people (and businesses) who legitimately have your email address and inform them of the change of email address.


 

Types Of Fake Email Addresses


The most common type of fake email address can be replicated with a simple function in Ruby.



 

 

 
 


 
  	
I loved the one I got for cut rate automobile insurance, especially since the real giveaway here is the .cu domain, which happens to be the country of Cuba. 


Automobile insurance from Cuba sold in the US? I don't think so. How stupid do these people think we are?


  
 


 

 

 




 
 

 
 









 
Firefox Task Manager: Find Your Resource Hog
 



by Paul Arnote (parnote)

 

 


It's happened to us all. We're cruising along using Firefox, have multiple tabs opened up, and then things slow to a crawl. Or, we install a new extension/add-on and find things running slower than normal. It is tempting to just close out Firefox and start over, but there is another choice that may be better.


Firefox has a built in task manager. It will show you exactly how much memory is being consumed by which tabs and which extensions, as well as its energy impact (or CPU cycles ... the higher the CPU cycles, the greater the energy impact). The latter is important to laptop users to help maximize battery life. To access it, you can click on the three line hamburger menu, then select "More ..." from that menu, and select "Task Manager" from the options. Alternatively, you can enter about:performance on Firefox's URL bar.


The task manager first made its debut in Firefox 64 last December.

 

 


If it's a tab that's slowing things down, position your mouse over the line that lists the tab that's slowing things down, as evidenced by the amount of memory and energy impact it shows. At the far right side of the window will be a large "X." Click on the "X" to close out that tab.


However, if it's an extension or add-on that's slowing things down, you can position your mouse over the item that's slowing things down. At the far right side of the window will be an arrow. Click on it to open up the Add-on Manager window, where you can disable or uninstall the offending extension or add-on.


If you work like I do, and you have many tabs opened up at any given time, the Firefox Task Manager is an important tool in your arsenal. As I'm writing this article, I have 12 tabs opened up, and have had as many as 20 tabs opened at various times. The tool makes it easy to find memory and energy hogs, and helps dispatch them to the digital netherworld. It sure beats just trying to guess which tabs and extensions/add-ons are guilty of causing the slowdown.




 
 

 
 









 
Repo Review: QPhotoRec
 



by CgBoy

           
QPhotoRec is a handy tool for recovering lost data from damaged or corrupted storage devices, or files you may have just accidentally deleted. Despite its name, QPhotoRec can recover many different kinds of files from FAT, NTFS, exFAT, ext2/ext3/ext4, ReiserFS, and HFS+ file systems.

 

 


QPhotoRec's user interface is relatively simple and well laid out. From the drop down menu near the top you can select a storage drive, and then below that you can choose which partition you want searched. You have to then select the appropriate file system type option. You can then set it to search the whole partition, or just the unallocated space (This option only recovers deleted files). The next step is to set where the recovered files will be saved to. For some reason, when I tried pressing Browse to change the output folder, it just gave me an io-slave error message (That was in KDE, it worked fine running in XFCE). But typing in the output location manually still works fine. After that, you can choose which file formats you want QPhotoRec to search for and try to recover.


Now just press Search and wait while it tries to find your lost files. Depending on the size of the storage drive, it can take quite a while, so just be patient. Any files that QPhotoRec has found will show up in a list on the screen, and will automatically be recovered and saved to the output folder. The recovered files will, however, have root ownership, so you'll probably want to change that afterwards.

 

 



One thing to keep in mind is that the original filenames and date stamps of the recovered files will most likely be lost. Of course, files can't be recovered if they've been overwritten, so the best way to insure that lost files are still recoverable is to not create or save any new data on the drive until you've fully recovered the lost files.


Summary

I was actually somewhat surprised at just how well QPhotoRec was able to recover some of my files that I had thought were long gone. Except for the file browser problem I mentioned earlier, I had no problems with QPhotoRec, and I would definitely recommend it.




 
 

 
 


 
 


 
 


 
 









 
ms_meme's Nook: Come Fly With Me To Linux Land
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PCLinuxOS Recipe Corner Bonus: 
Make Ahead Slow-Cooker Asian Peach Chicken Thighs
 





Make-Ahead Slow-Cooker Asian Peach Chicken Thighs




Ingredients:


To Freeze/Slow Cook

1/4 cup honey

1/4 cup soy sauce

2 tablespoons butter, melted

2 tablespoons chili garlic sauce

20 oz boneless skinless chicken thighs

1 bag (12 oz) frozen sliced peaches

 

To Serve


2 tablespoons cornstarch

2 tablespoons cold water

2 cups hot cooked white rice

1/2 cup sliced green onions

1/4 cup chopped fresh cilantro leaves

1/4 cup chopped roasted, salted cashews

1 lime, cut into wedges

 

Directions:



1. In labeled 1-gallon freezer bag, place honey, soy sauce, melted butter and chili garlic sauce; seal bag. Knead bag to mix well. Add chicken and frozen peaches; squeeze bag to thoroughly coat chicken and peaches in sauce. Lay flat, and freeze up to 3 months.



2. Thaw 12 to 24 hours in refrigerator, until completely thawed.



3. Pour contents of bag into 3 1/2- to 4-quart slow cooker. Cover and cook on Low heat setting 4 to 5 hours.



4. In a small bowl, beat cornstarch and cold water. Quickly stir into chicken mixture in slow cooker; cover. Increase heat to High heat setting; cook 5 to 10 minutes or until thickened.



5. Divide rice among 4 bowls. Divide chicken mixture among bowls of rice. Top with remaining ingredients.

 

Tips:


Sushi rice makes a great sticky side for this peachy dish, but any white rice will do.


Not crazy about cilantro? Try Thai or Italian basil instead.
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Screenshot Showcase
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Posted by francesco_bat, September 1, 2019, running Trinity
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Posted by Meemaw, September 1, 2019, running Xfce
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Posted by Meemaw, September 13, 2019, running Xfce
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Posted by mutse, September 9, 2019, running Trinity
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Posted by OnlyHuman, September 28, 2019, running e23
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Posted by parnote, September 7, 2019, running Xfce
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Posted by present_arms, September 1, 2019, running openbox
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Posted by sam2fish, September 18, 2019, running KDE
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Posted by tbschommer, September 1, 2019, running KDE
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Posted by tbschommer, September 14, 2019, running KDE
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The aboutEvent method is a re-worked copy of that method in scratchpad.

des asoutuent (se1f)
mbox = QUasszgeRok ()
mbox. setLzon CHessagesox. Lazormation)
box Sl adonTiLLe {"ALOGL"
mbox.5et32y” echeat (Tbeckgrounc suhize; colorbleck™)
mbox_satTaxt INQES “aurchpad?)
magText = (% 3 quick lannch \rn 4

‘tray resident application\n” +

Programed Ln Pylmada® +

" and PyCEs\aT

nko. 36t I fornat ivaTant (nsgTaxt)

nkox. setStandardBut tons (QessagaBo..0K)

ncox. utcon (dMessage3ox . 0k}

atox.

The exitApplication and trayTconActivated methods are the same as in scratrnpad

der exitapplicatior (sa1f): # Exit point
self.nide(
des trayloonn:

vated(seif, reason
Ceystentraylcon. Contaxs
SeLr.-ray_icon.cantexzhent (). show 1)
€107 season == GSySLeTrayToon Teigger
how )
ice_()
tivataRinden ()

1e
cele
sele

The Fral block of cade is much as in scratchpad.

if nae_ — '_main_
= OAppTieaTon (sys. arge)
2ED.5280u1 LUNLASTHANASHC_osea (¥aLse)
Zom - Lanenpadi)

4 contealize and resize
ax = torn.rrameteomerry(}

Cp = DDeskiopRiyel () . avallableGeometey (] -center ()
gz .movecerzer (sp)

ferm.move lqz. topleft ()]

app.exec_i)

As you can see, re-using an existing appication and modifying it has saved us a Iot of work.
Any of the examplas I Fave showr can b built this way. The one with the 300 buttens uses
a stacked widget with 10 pages In the same menrer as the two page alarm/timer
application.

Functions
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Here I have transparency turned or, just as implemented in the analcg clock. The oval
buttons ara created in thair stylesheet with 2 border-radius of hal* the height. The pale blue
background ic another button widget that is 1ot connected to any mathed so does nothing,
and which I pshed to the back by rignt clicking on it designer and choosing tnat option

These circular buttons have equzl width and helcht 2nc a stylasheet with a border radius set
to half the helght.

This version has full transparency and no background.
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by Peter Kelly (critter)

Launchpad

Now Urel. we have: a few applications of cur own, we should have a way of quickly acessing
them. These appiczt cns will not appear In the system menu unless you write a
freedesktop.org compatible .desktod file for each, znd place that In your
/usr/share/applications direccory. What you need is a persanalised apa ication launcher.

What features shou'd we look for in the launcher?

1. Always easly availabla, perkans hy a horkey FOmbIFZFan, £.g. Wir + X, or as a t-ay
resident utilivy, as we cid with scratchrad

2. Asingle button or izon to represent each anplicat on, and each of thesa sensitive to
eitfer 2 mousa click or keyp-ess.

3. Auto closing\Fiding after a selection has been mads.
4. Hotkey dosing if ycu decide not to launch any apalicat on.
5. Extansibe,
Wel, it “ums out that we alrezdy know how o implemert Il of thess faturas. Number 1
e usec in scratchpad ard the timerjalarm. Numbers 2 and 4 hzve been availzble s nce we
st developed the template. Numhe- 3 was availanie in Appsearch, dnrz and scratcapad

Number 5, all af aur aplications are extensible, sirce we are the developers.

What's left to decide is the appearance of the interface, and he-e we have a free hand. Here
are a few ideas.





img4.png
This is Ure Least of leunches. The Len butlons on Ure lefl control 10 peges of Ui
kedWidget on the right. These buttons may be activated by pressirg one of the function
keys F1 to F10.

The stackedV/idge: has 30 buttons on each Fage - a total of 200 appl catlon butons!

The ELtians not In use are not cornected to any applicatior launch metrad, and have their
Satvisible attrioute set to false so that they zr2 nct seen.

Creating the applicatian.

The easiest way s to reuse some code that we have already wirittan. The scratchpac
apolicaticn was a tray launched apglication, so we czn start by copying that, removing what
we don't nead and adding some new features.

I'm going to recraate the oval bar type in the fist screenshot, but the method is te sama
whatever you decide upon. In the examele, which will be zray resident, I have nat includec
the timer or scratchpad zpplications, as thesz are taemselves tray recident applications

As usual, create a new directory and copy over tha scratchpad.py, scratchgad.ui and
Update_ras.sh fles, renaTing the scrath pad files to launchpad fles, ard editing the
update_ras.sh fle to raplace both instances of scratchpad with launchpad, Add suitable
icons fo- this and each of the target applications.

Cpen launchpac..i in designer and dalete the textEdit widget. Add three new pushButtons.
Chang the forms WindowTitie to Launchpad, and change the window icon to whatever you
crose, ard the width to 435. Clear any stylesheet f-om the form.,
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The same s the previous image, but ith button background set to transparent. This may
be gifficult to see on some background images.

This is 2 mers traditional launcher. No transparency, but 1 have Jsed the line
setiindowFlags (Qt. FransleasHindowilint)

in the __init__ method to remove the top window bar. The eszape key closes it
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Crossward solution helper\n Shortcut - X

Changs Ure objectName of eacl bullon b something you and the python code will
reccanize:

btn_aclock
btn_apEfinder
btn_docz.
btn_thesaurus
ben_xword

Qts Launchpad
Uay resident application
Programmed in Python3

and PyQrs.
[vox |

Savait, 2nd rin update_res.sh to create the python code for the user interface.

The code

There is nothing rezlly new here, and the mejority of it shoulc, by now, o familier to ycu.
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Select all five buttons by cantrol clic<ing on them, and delete their zext from the property
editor.

Sel Une widlh Lo 74 end e “eight Lo 50.
Sel the ¥ value 1o 16, leave the X for now. Add Lhis stylesheet (o he buttons:
aeashuutron |

border: zpx solia 232672;

busdes-radics:
beckgroand celo

glireargradicnt (xl: 0, yl: 0, 52: 0, y2: 1,
Stop: O #adsetd, ston: - HobbEas):

RaweutAThe Tpxs)

¢ qlireargradient(xli 0, yl: 0, xE: 0, y2: 1,
top: O HobbEes, atos: - feSeafd);

Add a new pushButton and st these properties:

objectliame sta_background

x o
wideh 423

Beight “

Clear Lie Lext peoperly.

cltip  Fress escape To alde
Add this stylesheet Lo Uis bulton:

border: 3px solta 232672;
border-raaivs
betkgrond-celoe: $93cees;
color: blacki | Thic is the color of the texs i the ool tip.

Right clck on this new ~0ffon 2ne Selart send fo hack.

Set the form Height to 70.

‘Set the X values of the 5 smaller SLtons t 10, 95, 160, 265 and 350 respectively
ive 2ach a suitatle icen, and set the izon size to 40 x 40

Add a suitable tooltip to 2ach of the smaller buttcrs:

Analogue dodk\n Shertcut - C
Application finder/launcher\n Shortcut - F
Document launcha-\n Shortzut - D
Thesaurus applicaticn\n Shortcut - T
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item retarned

2 itens raturcd
3 itens raturmed

A lamhca generated function shauld he used where a function ahjert is exfected o fo make.
£ade more readale.

a = Listirangets, 21, )
printia) . 8 11, 14, 17, 20, 23, 26
y=tarhda 2%kt s - % -7 & salvay .
f£or valua in 2

print(y(valua), ere', ')

~ 52, 127, %

8, 385, 568, 67, 1212, 1333,

A lambca generated function has no name, but It mzy be bound t0 @ variable as abcve, or
passed as an argument t  funcion

a= L 4 s, 25, 1, 1, 23, 163
b= ListirilterUamda x: (x5 3 = U1, an
print k) 115, 255, 183

Editors Note: All of the cod for the Casual Python article serios is Gualable for download from hre.
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Frict ) 7 343

Erincran

In e above, note thal e results are prinied Gut in what seems (o be a random manier
TIs Is hecause a dierlanary Is an unordared collection o key, valus palcs. °F this Is rt what

you wzrt, import the rallections modle and 15e he OrderedDicr subclass

Irport calections

Gef pewersy (y, e
LaCtions Ordarsabict ()
Frinc(ly = ' 9
Frint(t = 1, %)
Zor indox in s
dlindav] = indax #4 y

raturn @
7 9

Erint(p2)

CrderedDict ([(4, 64), (6, 216), (7, 333), (3, 7221]

p2.icema() s

More on mapping and unpacking

Argumznts may be positional where the value Is taken from the order of the arguments, o
keywiord arguments of the form name=value. If keyword arcuments arz specitiad in the
function defintion, then they must supply a defau t value which will be cverridden if a value
is supplied. Keyword arguments supplied o the function i the fanclion call may be
accessed hy unpzcking them In-o a dict crary, whose name Is prefixed wirh a douhle
asteris« or star, **kwargs. Kayserd argumerts must follow a1y positional argumen:s or
starrec arguments.

daf uk(e, w, 5, i, *currency, *
Frint (‘Countries s\n' £ e s ', T 4wt e etand b o)
Frint ("Currancy:')

Zor i in currency:

Frint ()
Erinc("\nCapitale: )
for key in corted(capitale) :
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print (power._ ¢

Raise one numher tn the power of arcther - A% y.
Takes twa arguments of ty22 int or flaat:

x the base
y the exponent

Returns the rasult,

Function Arguments

 function call. The function
value’ for omitted arguments,

Function argumants, if any, are passed to the functier Ir
definition may prov ce defaul: values in the form *keyword
but thesz st follow any mendatory argumerts.

verynat

Take one argquusis of Lype ste”
ebali'Helle * + ame <710

greet (*zed’) + 55> Hello Fesdt

greet (1 4 55> Hello avecyone!

Starrad argumants in functions

Vihen the number of arguments cannot be detarmined beforehand, it s possiale to pass a
reference to multiple values by prececing the parameter with 3 **'. This function binds the
first arqument W a variable 'y’, and passes (he rest es a reference o a Luole 'x'. The
recurned object Is a dictianary of " keys and 'x' o the power of 'y’ values.

Gt povesaly, )t ¥ caloulate x ++ v
at + create an

7 dicticnary saject
+ Lo BUL e cusulls

§ show what was passed ta the Fiet-an

+ Ludex in x: + buily Ui dicolonary
a'index] = tngex *+ y

4 xaturn the diczionary to the
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A funcion may have a returr statement follcwed by an expression. If the return statemant
i missing or there is no expression following it, then the vala "None’ will be returnec.
Cthervise, the valus cf the expression s returred. V/hat is retumed s an object, and that
object may be 2 single valus, such as a numbar o~ multiple values in the ferm of a tuple.

e iyt

a2, 3
peinl i

Nene

A At vt
retura ceturn out ro exp:

ssion

s - @ 3
print

Nena

seram

s =@ 3 s
printis)

e iyt
P

return p, 4 retura multiple values Ln & tusle

€ a2, 3
printic)
typeit)

€ 5

<type 'tuple’>

Recursion

A recarsive function is one that calls itsaIf repeatedly. If a terminaticn corcition s 1ot
reached, then an infinite loop results. F Eonacci numoers can 2asiy be caicJated usng an
irerative loop, B recursion c2n make the cade easier fo follaw. The Fihonacel aiThers are
detined hy:

o= ol e Pne
With PG = 5 and F1 = 1

And the recarsive pytlion funciion might look like tis.

GeE fHE@:
ifn 0
seturn 0

elifu
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print1"{0} = {1)".farnat (key, ezpitals(ey]))
e = ‘Englana

- Halest

o - 'Scotlandt

§ = Merrheen Trelaaat

op = (pounas’, "pence’)

uk(e, #, ¢, i, gbp, England='Londor!,
Wales—t Cardize,
Seetland=Beinboght,
Horthern_relana='seltas')

The cutput rom the above will be:

Eng and, Wales, Scotlanc and Nerthern Ireland

Currency,
(lpounds, ‘perce)

Capitais:
Engand = London
Northern_lreland - Belfast
Scatland = Edinburgh
Walss = Cardiff

Higher Order Functions

A funciion that takes arcther function a5 an argumant is known as a highe order funcrion.
The kviltin map function is an exaple of a higher orcer fnction

def twicalx
*+Donole z numoer.®

AeF thricage) -
"Trasle z number.'!!
return ¢ + 3

aaf oparata(fure, x)
Preaites A Fmetion and 4 momber As arguments't

resull = fune ()
return zecult

operate (taice, 27) s
operate (thrlee, 27) #2081

Function Return Values





img16.png
return 1

raturn Finir-1) + Fino0

This fallows 22 definition clasely, hut has the disadvantage that for ezch pass thraugh the
function, the values have to be ra-calculatad. As the numbers get larger the numbsr of

calculations grows considerably larger. This cituation can be improved by riting previously
calculated values to a dictionary and Icoking tr2m up as requi

ip_atz

s, 22

e Fin(
for & in rangel?, n + 1)

£ib dictli] - £ib dise(i - 1] + £k dictli - 2]

erar b dietin]
print (£i5(23)) 1535

This methiod Can cuickly read pythons meximunn recursion depth. For large numbers, an
iterarive approach works herter.

Lambda Expressions

Also known as lambda forms cr lambda functions, they create anonymous furction objects
(o2zause of a lack of a namz). A lambda function is also known a3 a throw-aviay function.
Lambda fanctions are used 2xtensively in combination with the map builtin function,
Lambda Fanctions are similar Lo list comprehensions. The syntax of a lambda functi

st: expression

Lanbda 3y -

Thera car e 2s many arguments 2 recuired, but only one expressicr. There must be no
statemanzs o comments. Note tnat the argument aames are not var ables but place Felders
for values or variables that will be passec <0 the expression. There is 2lso nc -eturn

stateman:. Values are eturnad Implicitly by the expression.
m=Tamda peomavip) 8 creace fhe laneda chjast
=, 3, 7 4 dAeFine the vrriarle x

me) # % 3¢ the srguwent to
§ 5> 0 4 the result

Lambda expressions are mors usually defined at the point whzre they will be used.

for & ia rangeid):
str = larbda x: " fx
Priaf(tiA] item(1} vetursdt armat i, str(i))

0 items ceturned
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TorrentFreak

The place where breaking news,
BitTorrent and copyright collide
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crossword-clues.png
L. a raveling amusement show o circus

2.an organized series of concerts, plays, or movies,
typically one held annually n the same place.

3. a public display of works of art or ftems of inerest

4. recagnition of an important occasion by taking partin
an activiy that makes it special

5. a cake made of batter that is poured through a funnel
into hot fat or o, deep-fied unti crisp, and served
sprinkled with powdered sugar

6.a small show or stal at an exhibiion, fai,or circus.

7. alively event or party.

8. artform that primarly uses paint, a canvas and a
Spinning platform. The art i created by dripping the
paint onto the spinning canvas

. something that causes laughter or provides
entertainment.

10. 2 maze or series of passageways lined with mirrors
‘especially curved mirrors giving distorted reflections.
(NOTE: Answer has 2 spaces.)

11 sounds combined in such a way as to produce
beauty of form, harmony, and expression of
emotion.

12. an area of sideshows, games of chance or skil, or
other amusemens at a far or extibition.

13.a large celebration or party, typically a lavish and
boisterous one.

14. an amusement-park or fairground ride consisting of
‘a giant vertical revolving wheel with passenger cars
suspended on s outer edge.

15.a visually striking performance or display.

16. smallelectric vehicles driven for entertainmentin a
‘special closed space at a fai, etc., where the aim is
1oty to hit ther cars
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amusement
candy apple
celebration
clown

costume

county fair
exciting
fairground
festival

float

fun house
house of mirtors
jamboree
marching band
midway

parade

roller coaster
snow cone

spin art
wingding

bumper cars
carmival

circus,

com dog
cotton candy
dance
exhibition
Ferris wheel
fiesta

fried food
funnel cakes
ice cream
juggler
merry-go-round
music.

popcom
sideshow
spectacle

state fair
world's fair
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4s for the latter, the content varies from simple (and -ather vulgar) messages, of which on
is expected to renly, which happens to be the very thing that validates email
addresses to cyhercriminals.

For example, a simple message such as:

“Sitop sending me your F*¥ing phats.”

is obviously intended to stir up emotians, which hppens ta be a farm of social enginesring
If the email address is spoofed, it does not matter about the content, as these

messages will be deleted anyway.

Other Spoofed Addresses.

Let us ook at the rest of the collection, starting with these ccmpletely self explanatory
cxamples.

K55 7dE 3kkpasuCLENeN3 e, cdu. o
SHELGELCCI 1800y pr igSkndyBBb2nS £25ad e
EEPNQ4 - ODPATHCA03BGSEEAZ . us
LzhwS73azalesn. 5
1164y27558a83x8. -5
£ 025336 5 0maOmnd B£623ywe21 s
3427191#905a34v7940 mkn. s

These next examples appear to have come from New Venture Scrvices Corporation of
(drumroll, plcase) Drums, PA.

cegenlkjgf.desdhq. con
tngyem, desdhy
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Extended warrarty offers for automobiles
Cut rate auto insurance.
Vieight Inss programs

Offers ta reduce interest rates on credit card deht





img61.png
Finally, these examples give a cluz 2s to who is a member cf the parties resporsible for thi
nonsense.

nyomingerznursenizenslrer oxy
nyomingeripesltoscnarent .ors

At lzast we have a nickname to look aut for.

We Cannot Overstate The Obvious

The examples here are only a handful of what i possible of the type of spoofing to logk out
for. T am sure you may have come across different examales, or even found a different
pattem of spocfed email addresses from what I have observed.

At least, there are mechanisms in plce that can detect spoofed messages. G-Mail alrezdy
uses some of these mechanisms as we have seen oy simply laoking into the Spam folder.

While these mechanisms help, it is our own vigilance and cducztion that is the key to
praventing theft, ootn monezary and identity.
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The official website for New Venture Scrviccs Corporation is newveorp.com, not.
decdhg.com. New Venture Services Corperation is a retailer of demain names, and is a
competicor to GoDaddy.com.

Anything with admin for 2 usemame in an email address is 2 sign of trouble. No

legitimate email address should contain admin in the account name.

anirestodion. cu
Sanicantcotijp
sanizptongre. o
wrdluckyu g
sanicpeyiza)
.
anicpeluvsl

Thes next four examples are self explanatory.

s eyl .y,
i nJuibySnSH L Lpni . ng:
iR 0 100 £ Temg e pba
aniceichedmocukuihlbees .

Cekpbdd ey cdsds
33450045ga6upt

191672020840
nakLiises

The Yelp! service for business reviews often gets spoofed. (1 ¢ not even have a Yelp!
Account.)

atcyelp.con

3956ca txnyyels. con
-

The template contzining “uce” ollowed by tne usemame works excest when the program
generating the spam messages is emulated by a careless perzon. (Apparently, these eopl
are not the sharpest tools in the shed.)

useprorrekerftir=x.
useprornekerPtsn

Tnough L do not like feked email addrcsscs, 1 absolutely love these cxamoales (which
apparently must have hesn construed by Bart Simpson):

essyshrauylnefyusnre cvugds. il
£rvumpeszy

t helplesanut.con
o LyveL k1o 1o, trivialurgens. com

MRV 1640dvipgaxb o botruck. con
nooTeply131 a*roartiers oot
nooreplyty7l. cripts . conparedperformances. con

XCVBOUY:

¢y £bh . somsupply . ccm
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pclinuxos_search_index.jpg
Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

>

he PCLIniX0S magazine
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= “securezandon”

Soritg length - <lergrh of fage smatl compone
Fake_adireas_corponent — SecuveRa-dom. &l phanimer i c (5= ng_length
Fake_emsi1 = face address_conpeness 4 .7 < fake_address_corponent + Y37 +
Fake_aireas_conponent _dow-case + % s

The last line of Ruby code composes the fake sender email address as snown n this rather
extensive list

(fake emails in my Spam foider on September 9, 2019)

5736389W2£I2 VIV 5736235 87107790057 3698wzt S 26 3ynvvan.us
(on Scptember 12, 2019)

103207a70XLT372083KK. 4232005

L1332 0B3KK0 2032037041

(on September 17, 2019)

AGCEYSRDR. 1GoH6r LR ERacky B us
WAAZTEYL WL T yeCahds - yne s
TABHRZRS . TAS NECRSELISLurrLE us
LSGHWGEGH . 15 SHWGLGHE L Squughszw_us
RAC2CHap4 T02kyCPBNAR . 1 1C2 Ziapd 101 «/CRENAREAL < Zouapt L0 kycpEnih. ua
X3VOTOPY 3uETUPE T v Lupny us
TilenvITp. IiLenvlIpliisaviip.us
XYGSEORVL %3205 Lixyge g0nul ue
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(this cne came on September 18, 2019)

PAGAREXST . [AG 17

Tpatiescsins
(and again on September 19, 2018)

dgeeguRxS. dyesgvixdoegyzad us
£v796D5eVy INOIMIMALE . o1 7 96D 3Ty o ZHrlid LT T
F9QrVa0LZ . F90rUA0LIN f3GrvE0Le U
DmltyjSBe.Dnlty)Sickbrltyjsic.us
Y30¥elhxp. £90¥ L HAp Ly Sove i us

But Wait, There's Mors
& variation on the code produced thess crazy fake email addresses:

VR NG ZPARRRH ATV RV IFUT 00 T b e 7w 5w 011 7 207 -t
55HINL_INZSHSNLIXOBULG 5 5UH L0 T1NE L ApYqup L _x1n0 339Nt ECo . 2ot
EATPRRVATSTPTAT 1DPATSYIRYOTAPAT aelpuendDA) |

PaBpfed - et

Another Template Used Here

This template is used for faxe emalls that fun: ~to robocalls in the sense trat
simply replying t2 these mails validates your email address just as responcing to
robocal's validates your phone number

useprors
useprors
usepror:
usepor
usepror:
usepror
uacprors

In Ruby, tne fake email aderess is coded as follows:

abase of srail ad:

©(string_len
nere | 0% | zandom

h)
unk 1 %yieldingly

What About The Email Content?

Tre content of tnese fake emails varies. Trc latter type of fake sender cmail addresses are
normally assoriated with the type of Junk mail we normally get in au physical ma lhoxes,
such as:
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Radically Simple.

PCLinux<0S
Available in the following Desktops:

KDE LXDE Xfee
Mate  Enlightenment
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ms_meme1.png
Come fly with me to Linux Land we'll go
Fly with the rest as my guest

The booting’s never slow

‘Come fly with me you'l love Linux | Ko

Gome fly with me vl take the latest shell
With Captain T-STAR the hest by far
Through the net well sail

And Tux will serve a grub cockail

Once | get you up there
ou willind folks who care

Safe everywhere o virus 1o snare

Once | get you up there

ou willfind open source to share

ou may hear me sing some fun 1l bring

Gome fiy with me PCLOS is the top
Everything free for you and me.
You'll never distra hap

Come fiy with me the fun wil nev
Come fiy with me PCLOS is the top
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scrappler_rules.png
Li

SCRAPPLER RULE:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when' tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You wil not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles

1pointE A 1,O,N,R TL S, U

2 points: D, G

3 points: B, C, M, P

4 points: F, H, V, W, Y.

5 points: K

8 points: J, X

10 points:
6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!
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Possible score 247, average score 173.
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'SUDOKU RULES: There is only one valid soluion to_each
‘Sudoku puzzle. The only way the puzzle can be considered
Solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks willbe prefiled
for you. You cannot change these numbers in the course of the
game.

Each column must contain al of the numbers 1 through 9 and
o two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
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PCLITUXOS
Users Don't

Text
Phone
Web Surf
Facebook
Tweet
Instagram
Video
Take Pictures
Email
Chat

While Driving.

Put Down Your
Phone & Arrive Alive.
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twitter.jpg
Want 10 keep up on th latest that's
"going 0 with PCLINXOS?

Follow PCLInOS on Twitert

hitp:witer comfiluvpelinuxos
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PCLOS-Talk ﬁ
Instant Messaging Server

Signup TODAY! http://pclostalk pclosusers.col
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It’s easier than Ezmc?
It’s elemental
It’s light years ahead
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ms_meme.png
FRLITI0TE FETVIEND FOLITNN

When the sun goes down we all come out

Gather in the forum and begin to shout

Hey Hey Taxstar we are happy to be baoting PCLINUXOS
We are happy to be booting PGLINuX0S

This OS a real breakihough, lardy | am telling you
Always up to date, everything is first rate

We are hanpy as  bull after eating a plateful

For Texstar vays be grateful

Easy to instal it,radicalis what we call it

Texstar is made of zest and zeal, PCLIUXOS the ideal
This OS wil thrill you, alveays will fulfil you

Dawnload it now you wil know boots 5a fast never Siow
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A_Call_For_Articles.jpg
A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the.
PCLinux0S Magazine,
send an email to
pelinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles
specific to PCLinux0S.
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P05 GAMES ARCHIVE

WWW.DOSGAMESARCHIVE.COM
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Like Us On Facehook!
The PCLINUXOS Magazine
PCLinuX0S Fan Club
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